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ALWAYS A STEP AHEAD

AunaunIsinavszul iTrade

1. n1569An Internet Explorer (IE)

tila Internet Explorer

\&an?l -> Tools
-> Internet Options

fj Blank Page - Windows Internet Explorer

e
A |g, www.Fnsyru.s.cnm ]_
File Edit Yiew Favorites] | Tools |Hel|:|
n . " - elefe Browsing Histary, ., Ckrl+Shift+Del i )
Fawvarites =, Free Hi Sil
w | = e InPrivate Browsing Ckrl+ShifE+P
@ Blank Page Reopen Last Browsing Session
IrPrivate Filkering Ckrl+ShifE+F
InPrivate Filtering Settings
Pop-up Blocker »
SmartScreen Filker »

Manage Add-ons

Compatibility: Yiew
Compatibiliey View Settings

Subscribe to this Feed, .,
Feed Discovery ¥
Windows Updake

9

Developer Tools Fiz

Imtermet Options

s 5y Internet Explorer9 (IE9) uay Web browser Auq w2 Moxzilla Firefox , Opera uag
Netscape szuu iTrade f9'laisassu

syuu iTrade agl4'léAy Internet Explorer5.5 Service Pack 2 fiu'll
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A156vA Internet Explorer (IE6)
1.1 vihaia General Temporary Internet files
\#an? -> Delete Cookies...

-> Delete all cookies in the Temporary
-> adn Ok

IE 6

General | Se-:urit_l,ll F'rivau:_l,ll I:u:-ntentl Connections F'ru:ugramsl .ﬁ.dvancedl

—Home page
% f'ou can change which page to use for your home page.

Address: about:blank.

Uze Current | Uze Default I1ze Blank

— Temporary [ntemet filez

Fages pou view on the Internet are stored in a special folder
& for quick wiewing later.

2 Delete Cookies. ..

Delete Files. .. | Settings. ..

Delete Cookies x|

b vizited, for
Delete all cookies in the Temparary
! Internet Files Folder?

Clear Histor |
3 04

] o] 300 [ ] 3 I Cafaianes... I Accezsibiliy.. |

Zancel |

0k, | Cancel | Apply |
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1i22ia General Temporary Internet files

\#ani -> Delete Files...
-> fingn Delete all offline content
-> adn Ok

IE 6

Internet Options :

General I%ecurit_ul F'rivau:_l,ll Enntentl Connections F'ru:ugramsl .ﬁ.dvancedl
— |

2=

—Home page

% Y'ou can change which page to uze for your home page.

Address; about:blank.

Uze Current | Uze Default | I1ze Elank

— Temporary [ntemet filez

< Pages pou view on the Internet are stored in a special folder
@ Y for quick viewing later, 2

Delete Cookies... {Delete Files... | Settings... |

d

-
-
Delete Files

"l.., Delete all files in the Temporary Inkernet Files =d, for

‘fou can also delete all wour offline content stored

locally,

3 Delete all offline content

—

4|

|

x|

Hiztory

Cancel | Ezsibility...

I

 —

ok |

Cancel | Spply |
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A156vA Internet Explorer (IE7)

1i22ia General Browsing History
W8anil -> Delete...

-> adn Delete Files...

-> OK

-> adn Delete Cookies...

-> 0K

-> Close

1E7

ecurity I Privacy I Caontent I Connections | Programs I Advanced I

Home page

To create home page tabs, type each address on iks own line.
=l
[~

Use blank. |

about:blank

Use current | Use default |

Browsing hiskory

i

L

2 Delete. .. | Settings |
Search
p Change search defaults, Settings |
Tabs
Change how webpages are displaved in Settings |
tabs,
Appearance
Colors Languages | Fonts | Accessibility |

(0] 4 | Cancel | Apply, |

|5 Delete temporary files, history, cookies, saved passwords
") and weh Farm informati ==?
- . Cookies

IE 7
x

Temporary Internet Files 3 .

Copies of webpages, images, and media that Delete files. ..

are saved For Faster viewing, : )
Delete cookias. ., |

Delete history. .. |

Files stored on vour conputer by websites ta
save preferences such as login information.

History
List of websites vou have visited,

Form data

Saved information that you have byped into Delete Forms. ., |
forms.

Passwords

Passwords that are automatically filled in when
vou |og on to a website vou've previously
wisited,

Delete passwords. ., |

5

Delete all...

About deleting browsing histor

Close |
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A1569A Internet Explorer (IE8)

o

1in7ia General Browsing History

\danfl -> Delete...
-> fingn= Temporary Internet Files
-> @fingni Cookies
-> Delete

1ES

ecurity I Privacy I Caontent I Connections | Programs I Advanced I

Home page

oy

To create home page tabs, type each address on iks own line.
=l
[~

Use blank. |

about:blank

Use current Use default

Browsing history

Delete temporary files, history, cockies, saved passwords,
) and web Form inFormation.

™ Delete browsing history on et
2 Delete... | Settings |
Search
p Change search defaults. Settings |
Tabs
Change how webpages are displaved in Settings |
tabs,
Appearance
Colors Languages | Fonts | Accessibilicy |

21|

(0] 4 | Cancel | Apply

IE 8

Delete Browsing History

3

x|

[" Preserve Favorites website data

Keep cookies and temporary Internet files that enable vour Favorite
websites to retain preferences and display Faster,

v |Temporary Internet files
Copies of webpages, images, and media that are saved For Faster
viewing,

[v |Cookies
Files stored on wour computer by websites to save preferences
such as login information,

I History
List of websites you have visited,

" Form data
Saved information that vou have typed inta Forms.,

[” Passwords

Saved passwords that are automatically filled in when vou sign in
to a website vou've previously visited,

[ InPrivate Filtering data

Saved data used by InPrivate Filkering to detect where websites may
be automatically sharing details about your wvisit.

4

About deleting browsing histar

Cancel I

Delete |
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o

1i22ia General Browsing History

\#ani -> Settings (1199 Delete)

1E6 -> §inii Every visit to the page
-> 0K
IE7 , IE8 -> §inii Every time I visit the webpage

-> 0K

Settings

Security I Privacy I Content I Connections | Programs I Advanced I

Home page
l/? To create home page kabs, type each address onits own line,
L] ,)
e about:blank. ;I
-
Use current Use default | Use blank |
Browssing history
"l_ I Delete temporary files, history, cookies, saved passwords,
) and web Form information,
2 o
[ Delete browsing hiskory on exit 7
Delete... Settings |
Search
p Change search defaults, Settings |
Tahs
“hange how webpages are displaved in Settings |
tabs,
Appearance
Colars | Languages | Fonts | Accessibilicy |
QK | Cancel | Apply |

A

Settings

Temporary Internet Fil

X

— Temporary Internet Files

Internet Explorer stores copies of webpages, images, and media
For Faster viewing later,

Check For newer versions of stored pages:
3 Every time I wisit the webpage
'f-' Every time I start Internet Explorer
" Automatically
 Newer

Disk space ko use (8-1024MB)
{Recommended: S0-250MB)

I 1024 3:

Current location:

C\Documents and Settingsisuthasines. kiLocal
Settings) Temporary Internet Files',

Maove Folder... Wigw objects Wigw Files

—Hiskary

Specify how many davs Inkernet Explorer should save the lisk

of wehsites vou have visited,
I 20 3:

Days to keep pages in hiskary:

4 ok | Cancel
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1.2 vin2ia Security

\#anfi -> lamau Trusted sites
-> Adn Sites
-> 1anfingn Require server verification (Https:)for all sites in this zone aan
-> Tuatav Add this Web site to the zone: AuW *.fnsyrus.com
-> nnAdd
-> Tuatav Add this Web site to the zone: WuW *.syrus.co.th
-> nnAdd
-> agwutiu'laie

o

iviuwasluas Websites: uazna -> Close

Generall  Security |l3rivacv I Content I Connections I Programs I Advanced I
1

Select a zone to view or change security setkings.

@ “|/]|O

Inkernet Local intranet | Trusted sites | Restricted

2 sites 1331 *, fnsyrus.com 113=NA Add
Trusted sites = .
ites | e o ~aG
This zone contains websites that you WUV *.fnsyrus.co.th LAz=NA Add
R krusk not ko damage your computer or 3 Trusted sites il
vour files,
Wou have websites in this zone,
% ou can add and remove websites from this zone, all websites in
—Security level For this zone Tl this zone will use the zone's security settings.
Allowed levels For this zane: Al 5
- - Medium . .
_ I _ - Prompts before downloading pokentially unsafe il wzbislis o i sue
conkent I Add
k P - Unsigned Activek controls will not be downloaded
- - Websites:
- - * Frsyrus.co.th RLEmnt e |
* Frisyrus.com
Cuskan level. .. Default ey |
i
o =
Reset all zones to default lewvel | _1. HIRRDRBaN
a

Require server verification (https:) for all sites in this zone

6
Ok Cancel | Apnly | ﬂl
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1.3 in2ia Privacy

\dan?l -> Advanced

-> fingn Override automatic cookies handing
-> First-party Cookies tilu Accept
_ -> Third -party Cookies tilu Accept
-> angn Always allow sessions cookies

-> OK
IE6 -> Pop-up Bloker
-> Block pop-ups linfingnaan
IE7 , IE8 -> Pop-up Bloker

-> Turn on pop-up Broker ﬁwﬁngnaan

General I Securit  Privacy | [Content I Connections I Programs I Advanced I

Settings

?:' To set a standard privacy level instead of using custom
settings, click the Default button,

Custom

- Advanced or imported sektings

Sites | Impork | Advanced | Defaulk |

Pop-up Elocker

@ Prevent mosk pop-up windows Fram Setkings |

appearing.

[ Turn on Pop-up Blocker .
TPchvate 5 iingnaan

. ‘,'-lﬁ_ ™ Do not colleck data For use by InPrivate Filkering

Disable toolbars and extensions when InPrivate Browsing
I starks

(04 Cancel Apply

i

a
=

Advance | Privacy Sett
1 i

First-partv Cookies Anilu Accept
Third -party Cookies Anilu Accept

ANDN Always allow sessions cookdes

o can choose how cookies are handled in the Internet

a
E=d 3 zone. Thiz owverrides automatic cookie handling,

— ﬁm_]ﬂ Override automatic cookies handing

X

- Cookies

v Dweride automatic cookie handling

First-party Cookies Third-party Cookies
% Accept ¥ Accept
" Block " Block
' Prompt " Prompt

W &lways allow zession cookies

4 oK

Cancel
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1.4 iih2ia Advance

10

ATIARAULASIABNTILARSINI TsunT] Microsoft VM wia'lai win'liwuidia Microsoft VM 1ivinans

Download wagvinawu Java (Sun) Wiihéngnaan

\&an? -> Advanced
-> LlRauavmiiitia Microsoft VM
-> wu Java (Sun) ihangnaan

-> 1A3a9fiTulsunsu Microsoft VM (fanwediaeing)
-> yinn'lufivhdia Microsoft VM 19ivinnns Download Tusunsu

Internet Options

Generall Securityl F'rivau:yl Enntentl Ennnectionsl Programs

Seftings:

2| x|

Advanced

[ Use inline AutoComplete

Usge smoath goralling
&] HTTP 1.1 seftings
W] Use HTTP 1.1

Usze Pazzive FTP [for firewall and D51 modemn compatibility]

D Uga HTTP 1.1 through prosy l:onnectu:uns
| £ Java [SunHINVU Java {Sun)’ ‘r’i—‘]ﬁﬂﬂﬂﬂﬂﬂ
@ Usze JRE 1.6.0_26 for <applety [requirss restarl]

2

EE] Micragaft Yk -‘— 3

[ Java console enabled (requires restart)

O Java logging enabled

JIT compiler for virtual maching enabled [requires restart)
¥ Multimedia

Enable Automatic Image R esizing

Enable Image Toolbar [requires restart)

Play animations in web pages
dl

Restore Defaults |

of

0k

Cancel |

Apply |

WindowsXp 11ivinn1s Download Tisunsu
[ Download Microsoft JVM ]

WindowsVista 14ivinn1s Download 1ilswnsu

[ Download Microsoft JVM ] ua¥ [ Download Microsoft JVM3805 ] way

[ Download Microsoft JVM3810 ]

Windows?7 1%ivinnns Download 1dsunsu

[ Download Microsoft JVM ] uag [ Download Microsoft JVM3810 ]
f&u¥u Windows7 wia Download Tusunsudausaaliivinnns Restart tadag

Tdsunsudonan an lddniiniuladuasisdn www.fnsyrus.com adnii Help -> Download & Manual

(ffumaunns Download Microsoft JVM wiin 27)


http://web1.syrus.co.th/download/msjavx86.exe
http://web1.syrus.co.th/download/msjavx86.exe
http://web1.syrus.co.th/download/msjvm3805.exe
http://web1.syrus.co.th/download/msjvm3810.exe
http://web1.syrus.co.th/download/msjavx86.exe
http://web1.syrus.co.th/download/msjvm3810.exe
http://www.fnsyrus.com/th/itrade/index.html
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1ih2ia Advance

viavinn1s Download Tusunsu Microsoft VM fluiidausasudy Wildiwda Advance Matlu Tools
-> Internet Option wiflauL@u

\&an? -> Advanced
-> 1Rauavmiiitia Security
-> 1in@ingn Enable memory protection to help mitigate online attacks* aan
(mn'lifihdiadenanlvina OK uazdinudusausa’liluniii 16)
-> Apply
-> OK

General I Security I Privacy I Content I Conneckions I Prograrns Advanced I

Setkings 1

% Security ;I
_D_F'.“Ev active content from COs ko run on My Computer™
O Allow active content ko run in files on My Camputer®
O Allow software to run or install even iF the signature is inv: 2
Check For publisher's certificate revocation
O Check For server certificate revocation®
Check for signatures on downloaded programs
[ Do not save encrypted pages ko disk
O Empty Temparary Internet Files Folder when browser is clc
Enable DOM Storage
3 Enable Inteqgrated Windows Authentication®
Enable memory protection to help mitigate online attacks*
Enable native ¥MLHTTP support

| [ Enable SmartScreen Filker |
4

<+

|

Bk

*Takes effect after you restart Internet Explorer

Restore advanced settings |

Reset Internet Explorer setkings

Resets Internet Explorer's setkings ko their defaul:

- Reset, ..
conditian.

:

‘fou should only use this iF yaour browser is in an unusable skate,

S 4

Windows7 mnéiingniiia Enavble memory protection to help mitigate online attacks* “3il6 Ilu
Muivdadiniaieg Widtuaisudlaluduanaudasialuil
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Windows? ‘liignunsatiniat Enable memory protection to help mitigate online attacks* 1u tiaia
Advance aan'ls

\#ani -> Start lamau
-> Control Panel
-> User Account .
-> Change User Account Control settings w3aunta3adiilu
Change User Account and Family Safety
-> \&au Scroll Bar avavgatilu Never notify
-> 0K .
-> vinAs Restart 1a3agini

dafiayuavgauadaa

Jj Motepad
% Remote Desktop Connection Aaliimimistatie

; < "
I i Microsoft Office Cutlook 2003 S

o Pictures
Iuéj)? Paint
sl

Music
Calculator

= Computer
d’ Getting Started

i Control Panel
! Connect to a Projector

Devices and Printers
Sticky Motes
Default Programs

% Snipping Tool
Help and Support

_‘{ﬂ KPS Viewer

»  AllPrograms

| |5£:.'-::-’1 programs and files
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-> User Account

Q-‘ |5 » Control Panel » v | 4 [ |52arch Control Panet P

| Adjust your computer's settings View by: Category =

Gl  System and Security
Review your computer's status
Back up your computer

Find and fix problems ! . Appearance and Personalization

User Accounts
'@' Change account type

Ch the th
T Network and Internet Ch::g: deeslv:taembeack round
&i Connect to the Internet g P g
e View network status and tasks

Adjust screen reselution
Chioose hernegroup and sharing cptions Clock Language and Region

L] Hardware and Sound Change keyboards or other input methods

View devices and printers

o

Kol g Ease of Access
I: Let Windows suggest settings
% Programs : Optimize visual display
W h .": Uninstall a program

Get programs

-> User Account

Search Control Panel

Control Panel Home 4

% User Accounts
Change your account picture | @GiVEOthEI’LISEI'SECCEEStUthiSCDmpUtEr

System and Securif
I ¥ i I@'Clﬂange account type

Metwork and Internet
Hardware and Sound m Windows CardSpace

Manage Information Cards that are used to log on to online services

Programs
e User Accounts @q Credential Manager
~  Manage Windows credentials
Appearance and

Personalization .
_ @ Mail
Clock, Language, and Region

Ease of Access
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-> Change User Account Control settings v3aunaia3asiiiu
-> Change User Account and Family Safety

14

B -, O  =EEs

=]

-~ - o -
@' U|S$ v Control Panel » User Accounts » |User Accnunt5| v | +5 | | Search Control Panel

Control Panel Home
I Make changes to your user account

Manage your credentials

5 Change your picture
Link online IDs

Manage your file encryption I mg' Change User Account Control settings I

certificates rii;‘ Manage User Accounts

Configure advanced user
profile properties

. To change your password, press Ctri+Alt+Del and select Change a password.
Change my environment

variables

-> \8au Scroll Bar a9an9da Never notify
-> 0K .
-> vi1n15 Restart 1a3a9lnai

-. =

AD-FNSYRUS\Administrator

-
'@? User Account Contrel Settings =

Choose when to be notified about changes to your computer

User Account Control helps prevent potentially harmful programs frem making changes te your computer.
Tell me more about User Account Control settings

Always notify

MNever notify me when:

i 6 ® Programs try to install seftware or make changes to
LADHAINT Never notify my computer

® Imake changes to Windows settings

l@ Mot recommended, Choose this only if you need to
use programs that are not certified for Windows 7
-- because they do not suppert User Account Control.

Mever notify

L 0K J[ Cancel
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la Restart ta3avi3ausaalvindu'ldi viyeia Advance 2nasy

W&an#l -> Tools
-> Internet Option
-> #1dia Advanced
-> Security
-> a1fingn Enable memory protection to help mitigate online attacks* aan
-> adn Apply
-> OK

General I Security I Privacy I Content I Conneckions I Programs Advanced I
Setkings 1

% Security ;I

] Alow active conkent Fram CDs ko run on My Computer
O Allow active content ko runin files on My Computer®
O Allow software ta run or install even iF the signature is inw: 2
Check for publisher's certificate resvocation
O check for server certificate revocation®
Check for signatures on downloaded programs
[ Do not save encrypted pages to disk
[ Empty Temporary Internet Files Folder when browser is clc
Enable DioM Starage
3 Enable Integrated Windows Authentication®
Enable memary protection ta help mitigate onling attacks™®
Enable native XMLHTTP suppaort
[ Enable SmartScreen Filker

a |

*Takes effect after you restart Internet Explorer

e

]

B

Restore advanced settings |

Reset Internet Explorer settings

Resets Internet Explorer's settings to their default Reset. .
condition,

L

ou should only use this if wour browser is in an unusable skate,

S 4
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Wiavinniséean IE Bausaaitzih Login Tusilamilaiiulad it www.fnsyrus.com uaz
1danman Internet Trading Zone w3a'1l# Internet Trading uazvinnisaénit FNSyrus iTrade

#1usu Equity (Viu) Windnitlanau

Equity

Login 10 === Logy

S =
VAX'HVIP VAXH-VIP

Standard Color

A

#&u%u Derivatives (Tfex) Tinanilanau

Derivatives



http://www.fnsyrus.com/
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2. Login 12inszuu'lii'le andniilamauiiia Login wintuszuuuazwudannudesalald
2.1 danintlsunsuiuiiudng vda &6 wia Please wait for loading wuiailng
g dadaanfimaslifitdsunsu JAVA Wivinn1s Download Microsoft JVM fudingsu'lais
www.fnsyrus.com a&nfi Help -> Download & Manual

WindowsXp 1%vinn1s Download 1usunsu
[ Download Microsoft JVM ]

WindowsVista 14ivinn1s Download Tusuasu
[ Download Microsoft JVM ] uay
[ Download Microsoft JVM3805 ] wag
[ Download Microsoft JVM3810 ]

Windows?7 13ivinnns Download Tilsunsu
[ Download Microsoft JVM ] uay
[ Download Microsoft JVM3810 ]

&

dumaunis Download Microsoft JVM (#1in 27)


http://www.fnsyrus.com/
http://web1.syrus.co.th/download/msjavx86.exe
http://web1.syrus.co.th/download/msjavx86.exe
http://web1.syrus.co.th/download/msjvm3805.exe
http://web1.syrus.co.th/download/msjvm3810.exe
http://web1.syrus.co.th/download/msjavx86.exe
http://web1.syrus.co.th/download/msjvm3810.exe
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2.2 dauiinTusunsudiu Error Click for Detail 1vivinnisdvdiiaiag
\8an?l -> Start

a 5tart|
-> setting

-> Control Panel
-> Add or Remove Programs

dafiayuatvgauadianauniteas

B Control Panel

Filz  Edit ‘iew  Faworites  Tools

Qe - Q- F| P=
Address IG' Contral Panel

II'_',. Accessibilicy Options
e baedags

#1111148 Add or Remove Programs

._1_

:'_:,:-.E\dd or Remaowe Programs I
sdministrative Tools
Auktomatic Updates
~# Date and Time

Lj\ Display

Flash Player

Folder Options
—Fonts

s zame Controllers
Intel{R) GMA Driver
anternet Cpkions
=|Java

vt Mebwork Connections

';h Mebwork Setup Wizard

Lphone and Maodem Options

s Power Options

saPrinters and Faxes

Realtek HD Audio Manager

ﬂl] Realtek HD Sound EFfect Manager
!‘ Reqgional and Language Options
<, Scanners and Cameras
Scheduled Tasks

@ Set Program Access and Defaults

5"!_‘3:.. Windows Catalog

% Windows Update
@ Settrade OnedcClick

Frograms

¢ Speech

Lackarn

Documents

Settings

L Metwork Connections

!

=%y Printers and Faxes
E Taskbar and Start Menu

Search 2 3

Help and Support

F—] Rumi

Log OfFF Fss, .,

Windows XP Professional
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-> w1 Tdsunsu Java (TM) Update
-> adnNTdsunsuilu

-> Adn Remove

-> Yes

-> vi1n1s Login winsyuu iTrade 1wl

§& add ne Demove Programs

Currently installed programs: [T Showupdates Sork by |Name vI

19

- Adobe Flash Plaver 10 Activey
. Adobe Flash Playver 10 Plugin

'y

0l Adobe Reader 7.0 Size  61.43MB
i3 eFinsmartPortal - Size  10.99ME
RISTET - i
B smart prine. S sunsuii¥e Java (13D Tpdate Size  40.93MB
™ =

| £:| Java(TM) & Update 26 Size  94.95ME
Click here For support information, Lsed rarely
To rernove this program From vour computer, click Remove, Remove

N7 Renove HAZNA Yes

ﬁ Microsoft \MET Framework 2,0 Size  58.28MB

LGRS £ dd or Remove Programs b 117.00MB

T2, Microsort .1 9 = 35.04MB

\.J') Are you sure you want bo remove JavalTM) & Update 26 Fram your compuker?

C Microsoft O & 257.00MB

Cla i M

T3 Microsoft © | e l o e 167.00MB

(@ Mozilla Firef —_— e 28.29MB

] PDFCreator Size  27.23MB

Sid Realek High Definition Audio Driver

gl Settrade OnecClick Size  15.56ME

Cﬁ, Skype web features Size B.05ME -

wind JAVA (TM) uiane version 19ivinnns Remove version ftiaafigaaanniauds Remove dunn

Agaauadu
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2.3 Internet Explorer 1flu IE9 dsfinsawianain IE8 wuilu IE9 WinA'lusodl
(winfin1sag Windows ilu IE9 ag'lianunsawdinldoussuu iTrade 'l dagvinnsas Windows Tnsiilu IE8

Lint)

-> Start 'lamau
-> Control Panel
-> Programs and Feature

-> View installed Updates (dhafiauu)

-> %1 Windows Internet Explorer9

-> adnad1 Uninstall

-> Yes

-> il Internet Explorer9th-TH Language Pack
-> Tiadnw Uninstall -> Yesiguifianfu

-> vinn5 Restart ta3a9lna

-> vinn5 Login wiinseuy iTrade Tl

| d’j Motepad | \ | ..‘ —_—

% Remote Desktop Connection Maliipaiciestior
D i ) Documents
% Microsoft Office Qutlook 2003

e Pictures
':9‘35 Paint

Music

Calculator

daflayuavgauadaanauintaas

II_;i’ Getting Started

. Control Panel
! Connect to a Projector

Devices and Printers

Computer

Sticky Motes

% Snipping Teool

ﬂ XPS Viewer

» All Programs

Default Programs

Help and Support

earch w5 and file:
||5 arch programs and files
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-> Programs and Feature

{_Jie) |5 » Control Panel » All Control Panel ltems » « | 43 [ Search Controt Panel 2|

Adjust your computer's settings Viewby: Smallicons

P Action Center i Administrative Tools [md AutoPlay

@ Backup and Restore % Broadcom Control Suite 3 | Color Management
Credential Manager ﬁ' Date and Time e Default Programs
[ Desktop Gadgets £ Device Manager % Devices and Printers
B Display @ Ease of Access Center Folder Options
Lll Fonts =1 Getting Started & HomeGroup
1 8 Indexing Options B2 Intel(R) GMA Driver @] Internet Options
EB Keyboard Location and Other Sensors B Mail
|| < Mouse "f" Metwork and Sharing Center L Notification Area Icons
| M Performance Information and Tools ! Personalization &:I Phone and Modem
! 3 Power Options 3 l@ Pragrams and Features f\J Recovery
: ﬂ Region and Language @ Remotefpp and Desktop Connections 4 Sound :
@ Speech Recognition @ Sync Center 1B System |
u_ Taskbar and Start Menu Troubleshooting 2, User Accounts
t 4'_!,. Windows Anytime Upgrade @ Windows CardSpace s Windows Defender
" Windows Firewall ‘E' Windows Update
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-> View installed Updates (dhasiauu)

@p » Control Panel » All Control Panel lterns » Programs and Features > | *¢ | Search Programs and Features
— eI e

Control Panel Home .
4 Uninstall or change a program

View installed updates | To uninstall a program, select it from the list and then click Uninstall, Change, or Repair.

'@ Turn Windows features on or

att Organize + = - @

Install a program from the S

network Name Publisher Installed On  Size Version
B Adobe Flash Player 10 ActiveX Adobe Systems Incorporated 22/11/2553 6.00 MB  101.102.64
.Broadcom MetXtreme-I Netlink Driver and Managem... Broadcom Corporation 15/104/2553 164 MB 122502
‘. Free IS0 Creator version 2.8 www.minidvdsoft.com 29/11/2553 T2
=] Magic ISO Maker v5.5 (build 0281) 29/11,/2553
@'—Z‘s Microsoft NET Framework 4 Client Profile Microsoft Corporation 25/1142553 388 MB 4030319
53 Microsoft Office Professional Edition 2003 Microsoft Corporation 14/12/2553 160 MB  11.0.5614.0
Lﬁ\c"Mware Workstation VMware, Inc 2171042553 150 GB  7.0.0.9911

L1} ]

— currently installed programs Total size: 1.71 GB
“J 7 programs installed

-> 11 Windows Internet Explorer9
-> adnu Uninstall
-> Yes

="
L 5 ﬂ » Control Panel » Programs » Programs and Features » Installed Updates - H Search Installed Updates }J

Control Panel Home

Uninstall an update

Uninstaill

Uninstall a program To uninstall an update, select it from the list and then click Uninstall or Change.
@1 Turn Windows features on or
ot Organize +  Uninstall = @
Install a program from the
network Mame %5 S Program Version Publisher =
: 61 S Aanu 11 Windows Internet Explorer? 11az0@ Uninstall
IDWindaws Internet Explorer 9 icrosoft Windows Microsoft Corporation 3
1 L%

icrosoft Windows Microsoft Corporation

51 Hotfix for Microse?" Microsoft Corporation
Iﬂ Update for Micros: TR -

[ Security Update fo
[ Security Update fo
571 Security Update fo!

577 Security Update fo.

Microsoft Corporation

\ ; ; Microsoft Corporation
.’E Are you sure you want to uninstall this update? P

— 6

Microsoft Corporation l

Microsoft Corporation

Microsoft Corporation

[2 Update for Microsy, Microsoft Corporation
[ Update for Microsoft Windows (KB2454826) Microsoft Windows Microsoft Corporation
571 Security Update for Microsoft Windows (KB2425227) Microsoft Windows Microsoft Corporation
[277 Security Update for Microsoft Windows (KB2393802) Microsoft Windows Microsoft Corporation
[ Update for Microsoft Windows (KB976902) Microsoft Windows Microsoft Corporation
E"‘l Security Lndate for Microsoft Windows (KR241960401 ™ Mirrosnft Windows Ml'rrlncnﬂ' Cornnratinn : =

. _I Microsoft Corporation Parent name: Microsoft Windows

Support link: http://go.microsoft.com/fwlink/?Linkld=133041
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-> wndl Internet Explorer9 th-TH Language Pack

-> Wimdna1 Uninstall

-> YestduLsiendgu

-> vinnns Restart 1329
-> ¥i1n15 Login wdinsguy iTrade Tn

2.4 daTilsunsu iTrade aanTidsunsuluidiu

dan?l -> View
-> Toolbars

-> fingn Google toolbars aan .
-> wsamndl Yahoo toolbars Alvivnfingnaanizudu
-> ¥i1n15 Login wdinsguy iTrade Tw

@ Back.
v Status Bar

Address @

vorites

Explorer Bar

Taools

{1z} - Microsoft Ind

Help

v Standard Bukkons
v fddress Bar
ko Links

Go To
Stop
Refresh

Esc

] w Lock the Toolbars 3

Texk Size
Encoding

Cuskomize, ..

Source
Privacy Repark. ..
Full Screen

Fi1

23
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ALWAYS A STEP AHEAD

2.5 daldsunsu iTrade umiinTdsunsudnve Load ile

W&an? -> Tools
-> Internet Option
-> luniin General
-> @Adn Setting 1199 Delete
-> View Objects...
-> adnanAlna iFIS
-> L8an Remove
-> Yes '
-> wnndl iFISd ad&nan'lWa iFISd
-> L8an Remove 1dufu
-> Yes
-> ¥i1n15 Login wdinsguy iTrade Tn

f,"-‘ Elank Page - Windows Internet Explorer Internet Options ﬂll
p———

Y Ig- v, frsyrus, com 1 | General ||Security I Privacy I Caontent I Connections I Programs I Advanced I
-
Fil= Edit  Yiew Favoritei Tools |He|p Home page
< Favorites | i g Fres H Delete Browsing History... Ctrl+shift-+Del To create home page tabs, bype each address onits own line.
InPrivate Browsing Ctri+Shift+P | -,

=

InPrivate Filkering Cerl+5Shift+F LI
InPrivate Filkering Settings

@ Elank Page Reopen Last Browsing Session

Use current Use default | Use blank |
H »
Pop-up Blocksr Browsing history
SmartScreen Filker 3
ErD Aekkers d Delete temporary files, histary, cookies, saved passwords,
2 and web form information,
Compatitiity View [ Delete browsing histary on exit 3
Compatibility View Settings
Delete. .. Settings |
Sutiscribe Eothis Feed. .. h
Feed Discovery » Sheid
windows Update p Change search defaults, Settings |
Dewvel Tool Fiz
2 eveloper Tools T
ki Change how webpages are displayed in Settings |
kabs,
Appearance
Colars | Languages | Faonts | Accessibility |

[o]4 I Cancel | Anply I
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-> view Objects...
Temporary Internet Files and History Setting il
~ Temporary Inkernet Files
Internet Explorer stores copies of webpages, images, and media
fFor Faster viewing later,
Zheck for newer versions of stored pages:
* Every ktime I visit the webpage
- Every time I start Internet Explorer
™ Aukomatically
" Mever
Disk space ko use (B-1024MB) I 50 3:
{Recommended: S0-250ME)
Current location:
C:\Documents and Settingsisuthasinee. kiLocal
Settings! Temporary Internet Files), 4
Maowve Folder. .. || View abjects I View Files
— Histary
Specify how many davs Inkernet Explorer should save the list
of websites vou have visited.
Days ko keep pages in history: 20 =
(0] 4 | Cancel |
-> adnuni'lwa iFIS -> L&an Remove -> Yes
-> wndl iFISd adnu -> 1&an Remove -> Yes
-> adnun'lwa Script Class  -> 1&an Remove -> Yes
-> 1i1n1s Login wiinsyuu iTrade 1wl
Ed Downloaded Program Files -0l x|
File  Edit ‘Wiew Favorites Tools  Help | ;'f

5 3 X 9 |@EE-

/..\]Search i Folders

\_,)’ Back - \_;J - lj}'

Address | C\wWINDOWS\Downloaded Program Files

EGE

ABNYINADN Remove

Program File = | Stakus | Tatal Size | Creation Date | Last Accessed | Version |
] CaxLauncherCrl ... Installed 152 KB 11/11/2010 9:55 11112010 1,0,0,4

[‘] Encrvpt Class = Installed 160 KB 3171042005 19:08 29/10/2010 §,0,0,3127
giFs | ) Installed 21044 B emove Program File | 0.10.49.4

Insl © 12,188k 0.10.4.4
Update 6
] ObiinNTChedk ... | Ins! 123 KB ' iFIS will be removed permanenth, g,0,0,1004
CiFficeScan Corp ... | Insl | Remove 156 KB A‘ fire you 5'-'“3’7 8,0,0, 1004

1[#] Script Class | Insl - 700 KE 1,0,0,9

= Properties

& wiwebControl C...| Insl 212 KB Yes Mo 7,4,7600,226
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ALWAYS A STEP AHEAD

2.6 dauiihTusunsudiu Popup wiv Internet Explorer has working stop uaslvinatlaTisunsu

\ila Internet Explorer

Wdanil -> yuaeunfiazasaa
-> susunaniinaacilu 100%

Foom Inm  Chrl +
Zoarm Quk Ckrl -

400%
200%
150% 2
2 125%
| & 100%
75
S0%,

-l

Cuskom... l

_|_|\-‘_J Unknown Zone (Mixed) | -5 = T, 10 |- |4

wazliivinnsderaiagifoviuadous dia 2.2 &9 dia 2.5 4196iu

dia 2.2 lantihlusunsudu Error Click for Detail (»iih 18)
dia 2.3 Internet Explorer (flu IE9 dufinnsawianain IES uwilu IE9 (niih 20)
dia 2.4 ileTdsunsu iTrade aanTusunsu'ludiu (niih 23)
da 2.5 ilaTdsunsu iTrade uiinTusunsud1e Download il (niih 24)

-> diadera3aaasadausaaliivinnis Login winlussuy iTrade Tnsi
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ALWAYS A STEP AHEAD

3. fiumaunis Download Microsoft JVM #iuiintSu'leia

nantiniulaed www.fnsyrus.com a&nti Help -> Download & Manual

WindowsXp 17ivinn1s Download Tilsunsu
[ Download Microsoft JVM ]

WindowsVista 1vivinn1s Download Tusuasu
[ Download Microsoft JVM ] uay
[ Download Microsoft JVM3805 ] way
[ Download Microsoft JVM3810 ]

Windows?7 19ivinn1s Download Tusunsu
[ Download Microsoft JVM ] uay
[ Download Microsoft JVM3810 ]

8115y Windows7 1iia Download Tisunsu@ausaalvivinnis Restart ta3ag

\§an?l -> Download (MiayTusunsu)
-> [ Download Microsoft JVM ] #3a
-> [ Download Microsoft JVM3805 ]u3a
-> [ Download Microsoft JVM3810 ]

-> Run
-> Yes
-> 0K

27

4474 da9 Download Microsoft Java Virtual Machine uay Install Aauilfiaiu Tme download T@ana link d7as79
[ Download Microsoft 1WVM ]

1

[ Do

[ Do

e

wnload Microsoft JWM3805 ]
Waa

wnload Microsoft JWM3810 ]



http://www.fnsyrus.com/th/itrade/index.html
http://web1.syrus.co.th/download/msjavx86.exe
http://web1.syrus.co.th/download/msjavx86.exe
http://web1.syrus.co.th/download/msjvm3805.exe
http://web1.syrus.co.th/download/msjvm3810.exe
http://web1.syrus.co.th/download/msjavx86.exe
http://web1.syrus.co.th/download/msjvm3810.exe
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-> Run

File Download - Security ¥Warning E[

Do you want to run or save this file?

Mame: msjavxdc,exe
Type: Application, 5.24MB

From: webl.syrus.co.th

2 |
Fiun Save | Cancel I

l--’“‘-u YWhile files from thedlnternet can be uzeful, this file type can
o patentially harm yofr computer. [ pou do not trust the source, do oot
'\_ .

run ar gave this soffware. What's the nsk?

=101 x|

AN Run 2z1uwda 3l

msjav:cBa, exe From webl.syrus.co.th

ERNEREN
Estimated time left 1 hr 26 min {179KE of 5.24ME copied)
Download to: Temporary Folder

Transfer rate: 705 bytes/Sec

[T Cloze thiz dialog box when download completes

[pen [Mpen Folder | Cancel I
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-> Run dnasy
-> Yes

Internet Explorer - Security Warning 5[

The publisher could not be verified. Are you sure you want to run this
software?

Mame: msjvm3sis,. exe

Publisher: Unknown Publisher 3 AN Run %ﬂ A1

Don't Run I

Fun

should only run software From publishers wou trust, How can I decide what
software bo run?

@ This File does not have a valid digital signature that verifies its publisher, ¥ou

MicrosoftvM X

?f) Would wou like toinskall Ehe Microsoft W7
i

4

-> Yes

icrosoft i

Pleaze read the following license agreement. Press the PAGE DOWH key
to zee the rest of the agreement.

MICROSOFT YIRTUAL MACHINE -
EMD-SER LICEMSE AGREEMEMT FOR MICROSOFT
SOFTWWARE

IMPORTAMT READ CAREFULLY: This Microzoft End-User Licenze
Agreement ["ELILA"] iz a legal agreement between vou [ither an
individual or a zingle entity] and Microzoft Carporation for the Microzoft
zoftware product identified above, which includes “onling" or

electronic documentation and may include computer zoftware and
azsociated media and printed materals ["SOFTWARE PRODUCT" aor
"SOFTWARE"). By installing, copying, or atherwize wsing the
SOFTwWARE PRODUCT, you agree to be bound by the terms of this
EULA. If you do nat agree to the terms of this ELULA, you are not
authorized to uze the SOFTWARE PRODUCT. LI

Do you accept all of the terms of the preceding Licensze Agreement? [F pou
chooze Mo, Inztall will close. To install pou must accept thiz agreement.

5

ez Mo |
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ALWAYS A STEP AHEAD

-> OK

Microsoft vM Y

1 } The installation is complete.
|

30

-> p&n7 Download Microsoft JVM Tisunsusia‘lal
-> &11fu Windows?7 wiiavinnns Download Microsoft JVM (Fausaaniuatdiagwuntinansail

MicrosoftvM X

D you wank bo restart wour computer now?

Yes

i ] You musk restart vour computer before the new settings will take effect,

1N Yes 1770322111019 Restart
Mo

-> Yes .
-> vinn5 Restart ta3a9lna
-> 1i1n15 Login wdinsguy iTrade

usEnuanninegd Wiiuda 12958 d1Aa
#ha Support Information Technology
Tnsdwii +662 660 5361-4

Tnsa1s +662 660 5360

E-mail: it-support@fnsyrus.com


mailto:it-support@fnsyrus.com



